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PSI-3451 Projeto de CI Lógicos Integrados 
 
 

 
 
Sejam bem-vindos ao laboratório do PSI. Esta primeira prática de VHDL pretende familiarizar o 
aluno com o software para simulação ModelSim. Através dele serão testadas diversas características 
da linguagem tais como tipos, entidades, processos e alguns comandos.  
 
Cuidados, observações e recomendações:  
 
a) Evite utilizar aplicativos do Windows quando estiver trabalhando nos ambientes (fazendo um 

projeto com o software da) Mentor Graphics ou Altera (fornecedores de CAD). A mesma 
recomendação vale também para o Linux. Usar, sempre que possível, os aplicativos associados 
às ferramentas de projeto. 

b) Todos os softwares utilizados são complexos. Nós procuramos nestas práticas dar ao aluno 
noções básicas sobre elas. Cabe ao próprio aluno, dado o seu interesse, explorar com maior 
profundidade o potencial das ferramentas de síntese e de simulação. Tutoriais, manuais, guias 
rápidos estão disponíveis geralmeste em *.pdf e *.html no help das ferramentas.  

c) Para fins de estudo após as aulas, salve todos os arquivos relevantes na sua área de trabalho da 
unidade de Rede (X:). Os arquivos salvos em unidades locais (C:) NÃO estarão disponíveis em 
outros computadores do laboratório. 

 
 

PARTE PRÁTICA 

 

São fornecidos 5 arquivos VHDL. Cada um deles será modificado durante a aula gerando 
outros 5 arquivos. No total serão analisados e simulados 10 arquivos VHDL. A seguir vamos 
descrever cada um dos modelos fornecidos e os conceitos de VHDL que podem ser observados em 
cada uma das simulações.  

Em cada experimento e respectivo arquivo VHDL será submetido à seguinte sequência de 
tarefas: captura-compilação-simulação.  

O procedimento para capturar, compilar e simular cada arquivo VHDL será explicado 
para o somador full_adder_1. 

O mesmo procedimento deverá ser depois repetido para todas as demais simulações (desta 
aula e das próximas aulas em que for utilizado o programa ModelSim. 

 

 

Preparação das Pastas e Arquivos para Simulação 

a) Ligar o computador e entrar no ambiente Windows. 

b) Utilizando o Windows Explorer acesse a sua área de trabalho na unidade de rede X. 

c) Na sua área de trabalho crie uma pasta X:\psi3451 e dentro dela pastas onde serão 
armazenados os resultados das práticas. Uma sugestão é criar uma pasta para cada aula 
(por exemplo, aula_2 para esta prática), mas cada aluno deve usar a solução que julgar 
apropriada. 
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d) Ainda com o Windows Explorer, selecione Rede=> NEWSERVERLAB => psi3451 
=> aula_2. Copie todos os arquivos deste diretório para a sua pasta X:\psi3451\aula_2. 
São 5 arquivos *.vhd: full_adder (1 e 2) e reg_bank_simplificado_(1 2 e 3).  

e) Como serão realizadas 10 simulações, duas para cada arquivo fornecido, recomendamos 
que sejam criadas pastas separadas para cada uma das simulações com o objetivo de 
salvar adequadamente os resultados. Por exemplo, crie as pastas: 

 

  X:\psi3451\aula_2\fa_1  

  X:\psi3451\aula_2\fa_1m (para o full_adder_1 modificado) 

  X:\psi3451\aula_2\fa_2  

  X:\psi3451\aula_2\fa_2m (para o full_adder_2 modificado) 

X:\psi3451\aula_2\rb_1 

X:\psi3451\aula_2\rb_1m (para o mux1 modificado) 

X:\psi3451\aula_2\rb_2 

X:\psi3451\aula_2\rb_2m (para o mux2 modificado) 

X:\psi3451\aula_2\rb_3 

X:\psi3451\aula_2\rb_3m (para o mux3 modificado) 

 

 Transfira cada um dos 5 arquivos VHDL, copiados do serverlab para as 5 pastas 
correspondentes (sem a terminação m). 

 

1) Captura e simulação do somador completo full_adder_1 (com atrasos inerciais) 

 

ATENÇÃO: o procedimento apresentado a seguir, de CAPTURA, COMPILAÇÃO E 
SIMULAÇÃO do arquivo full_adder_1 no programa ModelSim deverá ser seguido em todos os 
demais experimentos a serem realizados nesta e nas demais aulas práticas que terão como case a 
ferramenta ModelSim. 

 

a) Abra o arquivo full_adder_1.vhd (já salvo na sua pasta X:\psi3451\aula_2\fa_1) usando 
o WordPad.  Este somador está codificado no modelo VHDL dataflow.  

Conceitos VHDL deste modelo: 

• Biblioteca Library IEEE 

• Comando use IEEE.STD_LOGIC_1164.all 

• par entity/architecture 

• declaração de sinais internos  signal ..... 

• transferência de sinais <= 

• tipo STD_LOGIC 
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• atraso inercial after. ATENÇÃO: os atrasos anotados no modelo devem ser 
cuidadosamente observados e identificados durante as simulações.  

• a descrição arquitetural comparada às equações acima. 

 

b) Clique no botão Iniciar (do Windows) e digite modelsim no campo de busca. Nas opções 
que surgirem, escolha modelsim. Isto disparará o software (certifique-se que trata-se do 
modelsim se 10 ou 10.1d). 

c) Feche a janela de boas vindas e de release notes do modelsim, caso esta janela abra 
automaticamente. 

d) Observe inicialmente que há uma janela "Library" de bibliotecas VHDL (já com várias 
instaladas). Observe que na parte inferior do software existe a janela "Transcript". Nela o 
usuário pode digitar comandos e verificar mensagens informativas e de erros sobre seus 
procedimentos. 

e) Para acessar os arquivos no diretório desejado, clique no menu File e em seguida em 
Change Directory. Selecione o caminho para o diretório criado para esta seção da prática 
(X:\psi3451\aula_2\fa_1). Observe que na janela "Transcript" aparece o comando cd 
X:\psi3451\ aula_2\fa_1.  

Observação: Isto demonstra que é possível executar as mesmas operações teclando comandos em 
vez de se usar o menu. 

f) O comando ls seguido de enter permite listar os arquivos no diretório. 

g) É necessário criar uma biblioteca (subdiretório) de trabalho no contexto do Modelsim. Esta 
será denominada work. Selecione a opção File -> New -> Library. Na caixa de diálogo, 
selecione “new library and a logical mapping to it” e digite work em library name e 
work em library physical name. Novamente, observe o que acontece na janela 
"Transcript". 

Pergunta: qual é o comando-linha correspondente? 

 

Observação: Na janela superior deve aparecer a biblioteca work listada junto com outras que já 
existiam (e que devem ser ignoradas no momento). A biblioteca work ainda deve estar vazia. 

Para compilar e importar arquivos VHDL para a biblioteca criada usa-se a opção de menu Compile 
seguido do submenu  Compile....  

h) Selecione o arquivo full_adder_1.vhd e clique no botão Compile. Clique em Done. 

 

Observação: Devem aparecer na janela "Transcript" as mensagens a seguir, indicando a correta 
compilação sem erros: 

a. # -- Compiling entity 

b. # -- Compiling architecture 

c. # Errors: 0, Warnings: 0 

Pergunta: qual é o comando-linha correspondente? 
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 Neste momento é possível observar que o arquivo VHDL compilado aparece na biblioteca 
work. Clique no símbolo + que aparece ao lado da biblioteca work e em seguida no + que aparece 
ao lado do módulo de interesse. Aparecerá o nome da arquitetura (dataflow) do modelo VHDL 
importado. 

 Para realizar a simulação do modelo VHDL (após sua compilação e captura para a biblioteca 
work) seleciona-se a opção Simulate→ Start Simulation no menu.  

i) Na caixa de diálogo, escolha a janela "Design", expandindo a biblioteca work e 
selecionando a entidade full_adder_1 (já compilada). 

j) Clique no botão Optimization Options. Será aberta uma janela com as opções de 
otimização onde modificaremos as opções de visibilidade (acesso) da simulação 

k) Selecione a aba Visibility → Apply full visibility to all modules (full debug mode) → 
OK. Carregue a simulação clicando novamente em OK na janela Start Simulation. 

Pergunta: qual é o comando-linha correspondente? 

 

Observação: O modelsim sofrerá uma mudança no layout e onde estava a janela Library, deverão 
surgir duas abas chamadas "Sim" e “Library”. A primeira será um ambiente direcionado a este 
contexto de simulação. Deve também aparecer a janela Wave utilizada para visualizar os sinais de 
interesse. 

l) Na aba “Sim” selecione o módulo de interesse com um clique simples. 

m) Certifique-se de que todos objetos da entidade em questão estejam visíveis habilitando 
no menu View as janelas Objects, Processes e Locals. 

n) Clique em Add → Wave → All items in region. Todos os portos de entrada e saída do 
modelo VHDL serão transferidos para a janela Wave do simulador. No caso do 
full_adder os portos são: 

sim:/full_adder/a_in \ 
sim:/full_adder/b_in \ 
sim:/full_adder/c_in \ 
sim:/full_adder/z_out \ 
sim:/full_adder/c_out 

 A partir deste momento, o simulador está pronto para receber os comandos referentes aos 
estímulos de entrada que se deseja observar (comando force) assim como ao avanço no tempo de 
simulação (comando run). 

 Por exemplo, o comando run 100ns avança o simulador este intervalo de tempo. Mas, observe 
que todos os sinais estão indeterminados pois não foram ainda especificados valores iniciais.  

 Por exemplo, os comandos: 

  force a_in 0 
  force b_in 1 
  force c_in 0 

  run 100ns 

mostrarão o resultado da soma A+B+C = 0+1+0 = 1. Atenção, os resultados também mostrarão os 
atrasos codificados no modelo VHDL sendo simulado. 

Comandos semelhantes permitem observar outras combinações dos valores das entradas.  
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Recomendação: por se tratar de um circuito combinatório de apenas 3 entradas, realize a simulação 
testando a tabela da verdade completa (através dos comandos force/run) para certificar-se que o 
código está correto. 

 

Caso se deseje reiniciar a simulação a partir do instante zero basta usar o comando restart. 

 Apesar de não ser necessário para o caso do full_adder, vamos ilustrar o formato do comando 
que cria estímulos periódicos (como é o caso de um clock, por exemplo, que será usado em diversos 
módulos sequenciais do projeto). 

  force -freeze a_in 1 0, 0 {10 ns} -r 20 

Este comando cria um sinal a_in de período 20ns e transição em 10ns (50% de duty cicle). 

 

Pergunta: como é o comportamento do circuito em termos de tempos de atraso? De que forma são 
as dependências entre as operações lógicas na descrição VHDL e como elas influenciam os atrasos?  

 

 DICA:  PARA FACILITAR AS PRÓXIMAS SIMULAÇÕES 

 É possível criar um script (arquivo de texto xxx.tcl) com todos os comandos-linha que se 
desejam repetir. Por exemplo, podem ser salvos no script todos os comando apresentados acima 
relativos à criação da biblioteca seguida da compilação do arquivo VHDL e seguida pelos 
comandos para a simulação do código ou, alternativamente, podem ser salvos somente os comandos 
usados durante a simulação do código. Para verificar todos os comandos que estão ativos na janela 
transcript utilize o comando history. Para criar o arquivo xxx.tcl, inicialmente certifique-se que a 
janela transcript contenha apenas a sequência de comandos desejada. Uma vez que a sequência de 
comandos esteja correta, ative a janela transcript clicando com o ponteiro do mouse sobre qualquer 
lugar desta janela. Em seguida clique em File-> Save Transcript As e na janela que aparece 
selecione a pasta em que deseja salvar os comandos e na janela apropriada escreva 
nome_qualquer.tcl e salve este arquivo. Caso precise, o aluno poderá editar diretamente o arquivo 
criado (é um arquivo texto) através de um editor de texto, apagando ou incluindo comandos. 

 Para ativar este script, com a janela Wave ativada (estando nela carregado os dados do novo 
circuito a ser simulado) clique em File -> Load -> Macro File e selecione nome_qualquer.tcl. Isto 
irá disparar uma nova simulação com exatamente a sequência de comandos do script, evitando a 
necessidade de repetir cada comando do simulador na nova simulação. 

 

2) Captura e simulação do somador completo full_adder_1 com atraso delta 

 
a) Faça uma cópia do arquivo full_adder_1.vhd e salve este novo arquivo com o nome  

full_adder_1_delta.vhd na pasta X:\psi3451\aula_2\fa_1m.  

b) Em seguida modifique o arquivo (com o programa WordPad) removendo todas as 
menções de atraso (AFTER k ns). 

Conceitos VHDL deste modelo: atraso DELTA. 

 

c) Repita o procedimento de captura, compilação e simulação  cf. descrito no item 1 
acima.  
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Recomendação: realize a simulação com várias combinações de valores de entrada (do comando 
force).  

 

Pergunta: como é o novo comportamento do circuito em termos de tempos de atraso? De que 
forma as dependências entre as operações lógicas na descrição influenciam os atrasos? 

 

3) Captura e simulação do somador completo full_adder_2 no modelo comportamental, com 
processo   

 

a) Abra o arquivo full_adder_2.vhd para a pasta   X:\psi3451\aula_2\fa_2. Ele está 
codificado no modelo VHDL comportamental (behavioral).  

 

Conceitos VHDL deste modelo 

• comando process (sintaxe) 

• lista de sensibilidade indicada pelos sinais que aparecem entre parênteses ao lado do comando 
process 

 

b) Repita o procedimento de captura, compilação e simulação  cf. descrito no item 1 
acima.  

 

Recomendação: realize a simulação com várias combinações de valores de entrada (do comando 
force). Guarde os resultados do Wave para comparação na seção seguinte.  

Pergunta: como é o novo comportamento do circuito comparado ao da Seção 1? Há equivalência 
entre os dois modelos? 

 

4) Captura e simulação do somador completo full_adder_2 no modelo comportamental, com  

lista de sensibilidade alterada   

 

a) Faça uma cópia do arquivo full_adder_2.vhd e salve este novo arquivo com o nome  
full_adder_2_lista_sensib.vhd na pasta X:\psi3451\aula_2\fa_1m.  

b) Em seguida modifique o arquivo (com o programa WordPad) removendo os sinais 
aux_xor e aux_and_1. 

Conceito VHDL deste modelo: lista de sensibilidade. 

c) Repita o procedimento de captura, compilação e simulação  cf. descrito no item 1 
acima.  

 

Recomendação: Realize uma simulação com a mesma sequência de estímulos adotada na Seção 3.  
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Pergunta: como é o novo comportamento do circuito comparado o observado na seção anterior? 
Como a lista de sensibilidade afeta a atualização/propagação de sinais? O que você esperaria caso 
as menções aos atrasos (AFTER) fossem retiradas? 

 

5) Captura e simulação do mux no modelo dataflow 

 

• Abra o arquivo reg_bank_simplificado_1.vhd que se encontra na pasta 
X:\psi3451\aula_2\rb_1. Este modelo é descrito no modelo VHDL dataflow. 

 

Conceitos VHDL deste modelo: 

• comando use work.my_package.all; 

• comando generic (no interior da entity) 

• parâmetro WIDTH 

• tipo NATURAL 

• tipo RB_SEL 

• tipo STD_LOGIC_VECTOR 

• comando when-else 

• comando others 

 

• Repita o procedimento de captura, compilação e simulação  cf. descrito no item 1 acima.  

Recomendação: por se tratar de um circuito combinatório de poucas entradas, realize a 
simulação com todas os possíveis valores de seleção.  

Pergunta: identifica o circuito como um mux do esquema da figura 2 (a) ou (b). Entendeu o 
uso do tipo RB_SEL? 

 

6) Captura e simulação do mux no modelo dataflow sem todas as opções de seleção   

a) Faça uma cópia do arquivo reg_bank_simplificado_1.vhd e salve este novo arquivo com 
o nome  reg_bank_simplificado_1_alter.vhd na pasta X:\psi3451\aula_2\rb_1m.  

b) Há duas alterações que devem ser feitas e testadas independentemente: 

1- Apagar (ou deixar comentada) a linha correspondente à seleção FIFO_OUT; 

2-  Apagar (ou deixar comentada) as linhas correspondentes à seleção FIFO_OUT e 
"OTHERS"; 

Conceito VHDL deste modelo: lista de sensibilidade. 

c) Repita o procedimento de captura, compilação e simulação  cf. descrito no item 1 
acima.  

 

Recomendação: Realize as mesmas simulações feitas no item 5 e observe as diferenças.  
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Pergunta: como é o novo comportamento do mux? O resultado desta simulação deve ser 
identificado com o esquema da figura 2 (a) ou  (b)? Que cuidado deve se ter para representar 
corretamente um mux combinatório em VHDL? 

  

7) Captura e simulação do mux no modelo comportamental, construção case-when 

 

a)  Abra o arquivo reg_bank_simplificado_2.vhd que se encontra na pasta 
X:\psi3451\aula_2\rb_2. Este modelo é descrito no modelo VHDL comportamental. 

Conceitos VHDL deste modelo: 

• comando process  

• comando case is 

• when 

• comando others 

 

b) Repita o procedimento de captura, compilação e simulação  cf. descrito no item 1 acima.  

Recomendação: por se tratar de um circuito combinatório de poucas entradas, realize a 
simulação com todas os possíveis valores de seleção.  

Pergunta: identifique o circuito com esquema da figura 2 (a) ou (b). Há alguma diferença 
em relação ao experimento da Seção 5?  

 

8) Captura e simulação do mux no modelo comportamental, construção case-when sem todas 
as opções de seleção   

a) Faça uma cópia do arquivo reg_bank_simplificado_2.vhd e salve este novo arquivo com 
o nome  reg_bank_simplificado_2_alter.vhd na pasta X:\psi3451\aula_2\rb_2m.  

b) Há duas alterações que devem ser feitas e testadas independentemente: 

1- Apagar (ou deixar comentada) a linha correspondente à seleção FIFO_OUT; 

2-  Apagar (ou deixar comentadas) as linhas correspondentes à seleção FIFO_OUT e 
"OTHERS"; 

Conceito VHDL deste modelo: lista de sensibilidade. 

c) Repita o procedimento de captura, compilação e simulação  cf. descrito no item 1 
acima.  

 

Recomendação: Realize as mesmas simulações feitas no item 5 e observe as diferenças.  

Pergunta: como é o novo comportamento do mux? O resultado desta simulação deve ser 
identificado com o esquema da figura 2 (a) ou  (b)? Que cuidado deve se ter para representar 
corretamente um mux combinatório em VHDL? 

 

9) Captura e simulação do mux no modelo comportamental, construção if-then-else 
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a)   Abra o arquivo reg_bank_simplificado_3.vhd que se encontra na pasta 
X:\psi3451\aula_2\rb_3. Este modelo é descrito no modelo VHDL comportamental. 

Conceitos VHDL deste modelo: 

• comando process  

• comando if-then-elseif-then 

b)  Repita o procedimento de captura, compilação e simulação  cf. descrito no item 1 acima.  

 

Recomendação: Realize as mesmas simulações feitas no item 5 e observe as diferenças.  

 

Pergunta: identifique o circuito com esquema da figura 2 (a) ou (b). Há alguma diferença em 
relação aos experimentos dos itens 5 e 7? 

 

10) Captura e simulação do mux no modelo comportamental, construção if-then-else sem 
todas as opções de seleção   

 

a) Faça uma cópia do arquivo reg_bank_simplificado_3.vhd e salve este novo arquivo com 
o nome  reg_bank_simplificado_3_alter.vhd na pasta X:\psi3451\aula_2\rb_3m.  

b) Apague (ou deixar comentada) a linha correspondente à seleção FIFO_OUT; 

 

Conceito VHDL deste modelo: 

c) Repita o procedimento de captura, compilação e simulação  cf. descrito no item 1 
acima.  

 

Recomendação: Realize uma simulação com a adotada na Seção 9 e observe a diferenças.  

 

Pergunta: como é o novo comportamento do mux? Identifique o circuito com esquema da figura 2 
(a) ou (b).  Que cuidados deve se ter para a codificação de um mux combinacional? 

 

 

 


